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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground.

The TReK IONConfig application provides the capability to create a set of Interplanetary
Overlay Network (ION) configuration files.

1.1 Getting Started

Start with the Introduction which provides an application overview. Next, try the Quick
Start Guides for “How Tos” for common functions. For help with details, reference the
Details section. See the FAQ and Troubleshooting section for helpful hints and solutions
to the common “gotchas”.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK
software, please contact us for technical assistance:

TReK Help Desk E-Mail, Phone & Fax:

E-Mail: trek.help@nasa.gov
Telephone:  256-544-3521 (8:00 a.m. - 4:00 p.m. Central Time)
Fax: 256-544-9353

If you call the TReK Help Desk and you get a recording please leave a message and
someone will return your call. E-mail is the preferred contact method for help. The e-
mail message is automatically forwarded to the TReK developers and helps cut the
response time. The HOSC Help Desk (256-544-5066) can provide assistance as needed
and is available 24x7.

3 Introduction

The TReK IONconfig application provides the capability to create a set of Interplanetary
Overlay Network (ION) configuration files.

If you are not familiar with Delay Tolerant Networking or the Interplanetary Overlay
Network software, please see the TReK Delay Tolerant Networking Tutorial for an
introduction to these topics.

Figure 1 shows an example of a Delay Tolerant Network (DTN) diagram that can be
created with the IONconfig application. In this example diagram, there are four nodes
with connecting ducts. Once the DTN diagram has been created and the node and duct
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properties have been populated, a set of ION configuration files can be generated for the
configuration.

PL GRD GRD GW FLT GWW PL FLT

(hooede 1] [iodde: 32675) [ S2ETT) (Mode 4)

Figure 1 DTN Diagram Example

For each node in the diagram, the following files will be generated. This includes ION
configuration files, script files that perform various tasks, and text files used by the
scripts and/or the 10ONizer application. Table 1 shows all of the files generated by
IONconfig that are used by ION administration programs. Table 2 shows the other files
that are generated that are related to TReK operations. Some of these files can also be
used without TReK. Items in both tables marked by an asterisk (*) are only applicable
for nodes connecting to ISS via the HOSC to Payload Ethernet Gateway (HPEG).

File Description

contact_plan.ionrc An ION configuration file that describes contact
times between nodes. Only applicable when
LTP is used.

proxy.bprc* If a proxy is used, this file configures ION to
work with the proxy. If no proxy is available,
the file is identical to the start.bprc file.

proxy.ipnrc* If a proxy is used, this file configures ION to
work with the proxy. If no proxy is available,
the file is identical to the start.ipnrc file.

start.bprc Contains the information for the ION bpadmin
program to use when configuring an ION node.

start.cfdprc Contains the information for the ION
cfdpadmin program to use when configuring an
ION node.

start.ionconfig Contains configuration information for the SDR
(data store).

start.ionrc Contains the information for the ION ionadmin
program to use when configuring an ION node.

start.ionsecrc Contains the information for the ION
ionsecadmin program to use when configuring
an ION node.

start.ipnrc Contains the information for the ION ipnadmin
program to use when configuring an ION node.

start.Itprc Contains the information for the ION Itpadmin
program to use when configuring an ION node.

stop.ionrc Contains information needed to successfully
stop an ION node.
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Table 1 ION Configuration Files Generated by IONconfig

File

Description

chk_node_num.bat*

A Windows batch file to ensure that node numbers in the
configuration files are the same as those in the current HPEG
configuration.

chk_node_num.sh*

A Linux bash script to ensure that node numbers in the
configuration files are the same as those in the current HPEG
configuration.

deletesdr.bat

A Windows batch file to delete the SDR (data store) associated
with the configuration. This should only be executed if the SDR
becomes corrupt. You will see a message in the ION log file if
that happens.

deletesdr.sh

A Linux bash script to delete the SDR (data store) associated with
the configuration. This should only be executed if the SDR
becomes corrupt. You will see a message in the ION log file if
that happens.

process_temp.txt

A file containing a list of the expected processes for the IONizer
to monitor.

proxy_available.txt

A file containing information on if a proxy is available for this
node.

renamelog.bat

A Windows batch file that renames the log file. 1ON must not be
running when this batch file is executed.

renamelog.sh

A Linux bash script that renames the log file. ION must not be
running when this script is executed.

startion.bat

A Windows batch file that starts all of the ION processes
associated with a node.

startion.sh A Linux bash script that starts all of the ION processes associated
with a node.

stopion.bat A Windows batch file to stop all of the ION processes.

stopion.sh A Linux bash script to stop all of the ION processes.

Table 2 TReK Related Files Generated by IONconfig

4 Overview of the User Interface

4.1

Main Window

The main window contains several areas as shown in Figure 2. In some cases an area is a
dock window that you can float or dock. To float a dock window, use your left mouse
button to click and hold the title area while dragging the window to another area of the
screen. To dock, use the title bar to drag the dock window over the main window and

drop.
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BN TReK IONconfig -- Untitled = | B S
File View Options Help
ION Configuration Files Base Directory: Use Static Routing | Generate Configuration | © [~] Reference Tme: | 2000-01-0100:00:00 '+ | |Generate Contact Plan
DRI
Message Area g X

Figure 2 Main Window

Toolbars

There are three toolbars: Configuration, Contact Plan, and Drawing. The Configuration
toolbar provides the capability to enter information that will be used when generating
ION configuration files. The Contact Plan toolbar provides support for generating a
contact plan. The Drawing toolbar provides access to drawing tools used to define a
Delay Tolerant Network (DTN) diagram composed of nodes and ducts.

Drawing Area
The Drawing area is used to define a Delay Tolerant Network (DTN) diagram composed

of nodes and ducts.

Message Area
The Message Area displays important status and error messages. The message area can

be cleared using the View menu.

4.2 Toolbars
There are three toolbars: Configuration, Contact Plan, and Drawing.

4.2.1 Configuration Toolbar
The Configuration toolbar is shown in Figure 3.

I0M Configuration Files Base Directory: Use Static Routing | Generate Configuration

Figure 3 Configuration Toolbar
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Each item in the Configuration toolbar is described below:

ION Configuration Files Base Directory

The ION Configuration Files Base Directory is used to identify the top level directory
where the ION configuration files should be placed when they are generated. Figure 4
shows a diagram with four nodes.

PL GRD GRD GW FLT GWW PL FLT

(hooede 1] [iodde: 32675) [ S2ETT) (Mode 4)

Figure 4 ION Configuration Files Base Directory Example

If the base directory entered was “/home/kirk/ion/”, the “/home/kirk/ion/” directory
would contain the following subdirectories after the configuration files are generated:

node 1
node 32678
node 32677
node_4

Note: The directory must exist when the “Generate Configuration” button is pushed.

Use Static Routing Checkbox

Static routing refers to the routing of bundles through a known path. With static routing
the sending node often relies on other nodes to forward bundles and the sending node has
no knowledge of the route or link availability along the route.

Generate Configuration
The Generate Configuration button is used to generate the ION configuration files. The
DTN diagram must be valid in order to generate the configuration files.

4.2.2 Contact Plan Toolbar
The Contact Plan toolbar is shown in Figure 5.

Reference Time: | 2000-01-01 00:00:00 (= |Generate Contact Plan

Figure 5 Contact Plan Toolbar

Each item in the Contact Plan Toolbar is described below:

Reference Time
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The Reference Time field is used to enter the Reference Time that should be used in the
Contact Plan. If you do not enter a reference time, the contact plan will be generated to
use the ION start time as the reference time.

Generate Contact Plan

The Generate Contact Plan button can be used to generate contact plans without
generating the other configuration files. The ION Configuration Files Base Directory
field must contain a valid directory and the DTN diagram must be valid before this
feature can be used.

4.2.3 Drawing Toolbar

The Drawing toolbar is shown in Figure 6. The Drawing toolbar is used to create a Delay
Tolerant Network (DTN) diagram composed of nodes and ducts.

Figure 6 Drawing Toolbar

Each tool is described below:

Tool Purpose

The Arrow tool is used to select one or more items in the diagram.

N The Duct tool is used to draw a duct between two nodes. A single line drawn
between two nodes defines two ducts: one in each direction.

The Node tool is used to place a node on the diagram.

The Properties tool is used to edit node or duct properties. This can be done
by first selecting a node or duct and then pushing the properties tool.

% The Delete tool is used to delete one or more items on the diagram.

Once a drawing tool is selected, it will stay selected until a different tool is selected.
While selected, you can perform the tool’s function repeatedly until selecting a different
tool. For example, if you select the Node tool, each time you use the left mouse button to
click on the diagram a new node will be created and placed at the location clicked. The
Node tool will stay selected and you can continue to place nodes until you are finished.
To perform a different function, such as drawing a duct or deleting a node, you will need
to select the desired tool.

4.3 Menus

The application menus are: File, View, Options, and Help. Each of these menus is
described in more detail below.
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File Menu
The File menu provides the capability to manage configurations and exit the application.

View Menu
The View menu provides the capability to clear the main window message area.

Options Menu
The Options menu provides access to the Messages dialog.

Help Menu
The Help menu provides access to on-line help and application version information.

5 Quick Start Guides
This section provides “How Tos” for common functions.

5.1 How to Create a DTN Diagram

The following steps explain how to create a DTN diagram with two nodes and the ducts
that connect the nodes.

The Drawing toolbar provides a way to select a drawing mode. The mode defines what
object will be drawn on the diagram when you press the left mouse button in the diagram
area. For example, when you push the Node tool, each time you press the left mouse
button in the diagram a node will be drawn. To deselect a mode, press the Arrow tool.

1. Push the Node tool button on the Drawing toolbar. Use the left mouse button to place
two nodes in the diagram as shown in Figure 7.
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P TReK IONconfig -- Untitled - (o=
- - —— e mm—— il - e— —
File View Options Help
ION Configuration Files Base Directory: E] Use Static Routing | Generate Configuration | © [~] Reference Tme: | 2000-01-0100:00:00 '+ | |Generate Contact Plan
NSRS
Node Node
Message Area g X

Figure 7 Two Nodes

2. Push the Duct tool button on the Drawing toolbar. Use the left mouse button to draw
a line between the two nodes as shown in Figure 8.

P TReK IONconfig -- Untitled . o
File View Options Help
ION Configuration Files Base Directory: E] Use Static Routing | Generate Configuration | © [~] Reference Tme: | 2000-01-0100:00:00 '+ | |Generate Contact Plan
DRI
Node  —— Node
Message Area g X

Figure 8 Two Nodes Connected

3. Use the left mouse button to double click on the left Node in the diagram. This will
display the Modify Node dialog shown in Figure 9. Enter an IP address for node 1
and Ground for the Node Name. Push the OK button to save and close the dialog.
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PN Modify Node ? ¥

General Configuration Administration Bundle Protocol CFDP LTP Security

Mode Mumber: | 1 |

Mode IP Address: | |

Mode Mame: | |

Output: Echo stdout to Log File Write Watch Characters
Service Mumber (int)  Receipt Action Add
Delete
oK Cancel

Figure 9 Modify Node Dialog for Node 1

4. Use the left mouse button to double click on the Node on the right side of the
diagram. This will display the Modify Node dialog for node 2. Enter an IP address
for node 2 and Space for the Node Name. Push the OK button to save and close the
dialog. The diagram should look like the one in Figure 10. Notice that once a node
has valid data the node will be displayed with a different color. The Node Name is
not required. But it can be handy to have node names.
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,
P9 TReK IONconfig -- Untitled - . - e = | E
- — o - - - - —
File View Options Help
ION Configuration Files Base Directory: E] Use Static Routing | Generate Configuration | © [~] Reference Tme: | 2000-01-0100:00:00 '+ | |Generate Contact Plan
DRI
Ground Space
oty T (New3)
Message Area g X

Figure 10 Two Nodes with Valid Data

5. Use the left mouse button to double click on the line that connects the two nodes.
This will display the Modify Duct dialog as shown in Figure 11. Notice that you can
define the properties of each duct: Node 1 to Node 2 and Node 2 to Node 1. Accept
the defaults by pushing the OK button to save and close the dialog. (Note: If you
plan to use the defaults provided in the Modify Duct dialog, you can skip this step
and the defaults will be used when you generate the diagram).

10
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P8 Modify Duct ? X

Mode 1 -= Mode 2 Mode 2 -= Mode 1

Duct Type
(® TCP  From Port: Ta Port:
(O STCP From Port: To Port:
(0 UDP  From Port: To Port:
(O LTP From Port: To Port:
Maxirmum Export Sessions: 5
Maximum Segment Size (bytes): | 1400
Aggregation Size Limit (bytes): 65000

Aggregation Time Limit (seconds): |1

Contacts

@ Constant Contact

Transmission Rate (bits/second): |1[JI]D[JDI] | Range: |1

() Specify Contact Times

Contact Times (Relative to Reference Time)

Start (seconds) End (seconds)  Rate (bits/sec) Range Add

Delete

Ok Cancel

Figure 11 Modify Duct Dialog for Node 1 and Node 2

The diagram is now valid and can be used to generate configuration files.

5.2 How to Generate ION Configuration Files

This section describes how to generate ION Configuration Files. ION configuration files
can only be generated for a valid ION diagram. The following steps assume the drawing
area contains a valid DTN diagram.

11
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1. Setthe ION Configuration Files Base Directory using the field in the Configuration
toolbar.

2. Push the Generate Configuration button. The ION configuration files base directory
will contain a set of subdirectories corresponding to the nodes in the diagram.

6 Details
This section covers various application details.

6.1 Modify Node

The Modify Node dialog contains multiple tabs. Each tab “roughly” corresponds to a
specific ION configuration file. If you need help remembering the purpose of a field, try
placing the mouse cursor over the field for a tooltip. Most of the fields are equipped with
a tooltip.

6.1.1 General Tab

The General tab is shown in Figure 12. The General tab contains information that isn’t
necessarily tied to a single ION configuration file. The Node Number is what makes this
node unique in the delay tolerant network. The Node IP Address defines the IP address
to use for DTN communications. The Node Name is a user defined name that is only
used for display purposes in the diagram. ION can generate watch characters that give
visual indications of the underlying protocol activity. These can be very helpful if there
are ever any errors transferring bundles. 10N watch characters are sent to standard
output. One or more services can be added for DTN enabled applications. The services
needed to use CFDP are automatically added when you enable CFDP. So there is no
need to add the CFDP service numbers (64 and 65) to the list. To add a service number,
you click the “Add” button to the right of the service list. This will place a row in the
service list with a default receipt action of “queue”. Just type in the service number and
change the receipt action if needed (the other option is “drop” which will drop the
incoming bundle if a DTN enabled application isn’t running to process the bundle).

12
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PN Modify Node ? ¥

General Configuration Administration Bundle Protocol CFDP LTP Security

Mode Mumnber: | 1 |
Mode IP Address: | |
Mode Mame: | |
Output: Echo stdout to Log File Write Watch Characters
Service Mumber (int)  Receipt Action Add
Delete
QK Cancel

Figure 12 Modify Node (General Tab)

6.1.2 Configuration Tab

The Configuration tab is shown in Figure 13. The SDR File Path is the directory where
your data store will be located. It needs to be a directory where you have write privilege.
Do not use spaces in the SDR File Path. The Heap Words describe how large to make
the data store. ION calculates the number of bytes for the data store by multiplying the
value you provide here with the number of bytes in the processor. For a 64-bit computer
that will be 8x250,000 or 2 million bytes if you keep the default. You will want to
increase this value for operations. A recommendation will be provided in a later TReK
release of the TReK DTN Tutorial.

Note: The SDR File Name is the name of the data store. You should use the default
value of ion. It is required unless you have set up a computer to run multiple nodes (see
ION documentation on how to do that). The wmKey must also have the default value of
65281 when using a single node per computer configuration.

You will need to modify the SDR File Path and the Heap Words. The rest of the defaults
will work for most configurations.

13



TREK-USER-0008

-
P Modify Node | 8
General Configuration | Administration Bundle Protocol | CFDP | LTP I Security |
SDR. File Path: fusr fion E]
SDR. File Mame: ion
SDR wmSize (bytes): 1000000
Config Flags: 3
Heap Words: 250000
Heap Key: -1
wmkey: 65281
wmSize (bytes): 5000000
wmAddress: ]
|
[ oK ] [ Cancel
e =

Figure 13 Modify Node Dialog (Configuration Tab)

6.1.3 Administration Tab

The Administration tab is shown in Figure 14. 1t is unlikely you will need to make any
changes to the default values shown.

14
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-
PN Modify Node - Rl - —— L8 i
| General I Configuration | Administration Bundle Protocol | CFDP | LTP I Security |
Mode Production Rate (bytes): -1
Mode Consumption Rate (bytes): -1
Inbound Heap Occupancy Limit (MB): -1
Outbound Heap Occupancy Limit (MB): -1
Horizon {seconds): 0
||
I oK I I Cancel

Figure 14 Modify Node (Administration Tab)

6.1.4 Bundle Protocol Tab

The Bundle Protocol tab is shown in Figure 15. TReK can automatically start the bpecho
application available in ION. This allows other ION instances to “ping” this node with
the ION bping application. The echo service is on by default. You can select a different
service number for the echo service. It is automatically added to the services list.t

There are four supported convergence layers: TCP, UDP, STCP, and LTP. The STCP
convergence layer is unique to ION and cannot be used with other implementations of the
bundle protocol (DTN). For each protocol you can select the number of Payload Bytes
Per Frame and Overhead Bytes Per Frame that are used internally by ION to calculate
estimated transmission capacity for each bundle and aid in congestion forecasting. It is
probably just best to use the default values. The Nominal Data Rate can be used to
throttle the amount of data sent from an ION node for TCP, UDP, and STCP. If you use
zero the data is sent as fast as the convergence layer will allow. The nominal data rates
are in bytes per second. The data rate for LTP is controlled in the contact plan.

! The echo service number defaults to the 1SS designated service number. At this time the service number
is undocumented and will change prior to operational use.

15
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You will need to modify the nominal data rate for the protocol you select. The rest of the
defaults will work for most configurations.

'5 Modify Node )

| General I Configuration Administration Bundle Protocol | CFDP | LTP I Security |

Start Echo Service

Echo Service Mumber: 2047

TCP Protocol Parameters STCP Protocol Parameters

Payload Bytes Per Frame: 1400 Payload Bytes Per Frame: 1400
Overhead Eytes Per Frame: 100 Overhead Bytes Per Frame: 100
Mominal Data Rate (bytes/sec): 0 Mominal Data Rate (bytes/fsec): 0
UDP Protocol Parameters LTP Protocol Parameters

Payload Bytes Per Frame: 1400 Payload Bytes Per Frame: 1400
Cwerhead Bytes Per Frame: 100 Owerhead Bytes Per Frame: 100

Mominal Data Rate (bytes/sec): 0

[ OK ] [ Cancel

[V — )

Figure 15 Modify Node (Bundle Protocol Tab)

6.1.5 CFDP Tab

The CFDP tab is shown in Figure 16. The CFDP checkbox enables/disables CFDP for
the ION node. If it is enabled, the service numbers (64 and 65) used by CFDP will be
automatically added. The File Fill Character is the fill pattern used by the ION CFDP
engine for missing data. The valid values are 0-255 (0x00-0xff). The PDU Segment Size
defines how large the CFDP Protocol Data Unit (PDU) will be. It is best to leave this
value unchanged. Small PDU sizes can cause performance problems with the CFDP
engine. The Inactivity Period defines how long a file transfer can be idle before the file
is canceled. The Max Event Queue Size determines the maximum number of events that
can be queued for CFDP. These events are used by TReK (e.g., to determine when a file
is completely transferred). The ION default is 20, but TReK configuration files
beginning with TReK-5.2.0 will default to 200. An event queue size of 200 works well
for a transfer of 300 simultaneous files via a dropbox. Indications that the event queue is
overflowing can include dropbox files being renamed with an .unknown extension and
the status for a CFDP transaction set to unknown. In those cases, increasing the Max
Event Queue Size and restarting ION may alleviate the problem.

16
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In most cases, the defaults provided in this dialog will work for most configurations.

P8 Modify Node ? X

General Configuration Administration Bundle Protocol CFDP LTP Security
CFDP

Queue
Dizcard Cancelled Files
[] require PDU CRC

File Fill Character (0-255):  |170

PDU Segment Size (bytes): |65|:||:||:|

Inactivity Period {(seconds): |864EIEI

Max Event Queue Size: |2|:||:|

Ok Cancel

Figure 16 Modify Node (CFDP Tab)

6.1.6 LTP Tab

The LTP tab is shown in Figure 17. The LTP checkbox enables/disables LTP for the
ION node. LTP uses “sessions” of data. Data generated by the node is referred to as
“export sessions”. Export Sessions are defined in the Duct dialog and stored in a map.
ION uses a hash table to access sessions quickly during processing. Maximum Export
Session Scale Factor controls how the maximum number of allowed export sessions is
calculated for this node. The minimum allowed value is 1.0 which creates a hash table
equal to the sum of all export sessions for this node. Increasing this value will create a
larger hash table and may increase lookup speed. The maximum value of the export
sessions will be the sum of all export sessions multiplied by the Maximum Export Session
Scale Factor. Unless you have reasons to believe that this has become a problem, just
leave the default.

The Screening checkbox allows you to require ION to throw away unexpected LTP data.
ION knows when data should arrive based on the contact plan. If screening is turned on,
then ION will drop any data received outside of a known contact. This requires computer
clocks at each node to be synced. It is recommended that you leave this option off.

17
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.
Modify Node I 8

e ——

| General I Configuration I Administration Bundle Protocol | CFDP | LTP | Security |

e

Maximum Export Session Scale Factor: | 1

Screening

OK ] [ Cancel

Figure 17 Modify Node (LTP Tab)

6.1.7 Security Tab

The Security tab is shown in Figure 18. Turning on the security prevents unwanted
messages from appearing in the ION log file.

18
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P9 Modify Node =

| General I Configuration Administration Bundle Protocal | CFDP | LTP | Security

Security
Future Security Properties...

OK ] [ Cancel

Figure 18 Modify Node (Security Tab)

6.2 Modify Duct

When two nodes are connected, there are two ducts between the nodes. The Modify Duct
dialog contains a tab for each duct. Figure 19 shows a DTN Diagram with two nodes
connected. Figure 20 shows the Modify Duct dialog displaying the properties for the line
between the two nodes (Node 1 and Node 2). The Modify Duct dialog provides the
capability to modify the Duct properties for data flowing from Node 1 to Node 2 and the
Duct properties for data flowing from Node 2 to Node 1. The port numbers all default to
the ‘official” bundle protocol port, but you can change it as needed.? The From Port is
the port associated with the first node in the tab title. The To Port is the port associated
with the second node in the tab title.

2 If you decide to run multiple nodes on a single computer, changing the port number is necessary.
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TReK IONconfig -- Untitled

:-Ehg

File View Options Help

IOM Configuration Files Base Directory:

PIRSEI=R

E] Use Static Routing |Generate Configuration | ° [T Reference Time: | 2000-01-0100:00:00 &

Generate Contact Plan

Ground Space

oty T (New3)

Message Area

-

Figure 19 DTN Diagram With Two Nodes
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P8 Modify Duct ? X
Mode 1-> Mode 2 Mode 2 -> Node 1
Duct Type
(® TCP  From Port: [4556 To Port: |4556
(O STCP From Fort: 4557 To Port: |4557
(O UDP  From Port: |4556 To Port: |4556
(O LTP FromPort: |1113 To Port: |1113
Maximum Export Sessions: 5
Maximum Segment Size (bytes): | 1400
Aggregation Size Limit (bytes): &5000
Aggreagation Time Limit (seconds): |1
Contacts
@ Constant Contact
Transmission Rate (bits/second): |1EIIIIEIIZIIIIIII | Range: |1
() Specify Contact Times
Contact Times (Relative to Reference Time)
Start (seconds)  End (seconds)  Rate (bits/sec)  Range Add
Delete
Ok Cancel

Figure 20 Modify Duct Dialog
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The four options available when you select LTP are related and should be set based on
your operational needs. The ION installation includes a spreadsheet and document that
can help you determine the values to use. The following paragraphs also contain
guidance. It is suggested that you run tests with these parameters to ensure that they
work well.

The Maximum Export Sessions impose flow control on LTP and helps prevent the space
in the data store from being filled up by LTP transmission sessions. The value you use
for Maximum Export Sessions should take into consideration the expected size of
bundles, the data rate for your transmission, any delay in the network (the time it takes to
get to the next node), and disruptions in the link (data that may not make it to the next
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node). If you underestimate the number of export sessions needed, you will impose an
additional throttle on your transmission rate. If you overestimate the number of export
sessions needed, you will use more system resources (memory) than necessary.

You can use the following formula to help determine the value to set for Maximum
Export Sessions (Note: The result is a minimum required value to prevent unwanted
throttling of data and may need to be increased after testing in an operational
environment.):

maximum export sessions = df * xr * rtt / (asl * 8)
Where:

df: disruption factor to cover undelivered data (suggested value 1.2)

xr: transmission rate defined for contact in this dialog

rtt: round trip time for packets on this network (generally twice range value)
asl: aggregation size limit as set in this dialog (times 8 to convert to bits)

The Maximum Segment Size defines the block size for outbound data. Typically this will
match the value for the “payload bytes per frame” set on the Bundle Protocol tab of a
node. The default value of 1400 should be sufficient.

The Aggregation Size Limit is used when smaller bundles are used with LTP. LTP will
aggregate these small bundles into a single “session”. The Aggregation Size Limit
defines how much data to collect before creating a new LTP session to transmit it.

The Aggregation Time Limit defines how long LTP will wait while aggregating small
bundles prior to sending them. Aggregating small bundles allows LTP to require fewer
sessions.

You should test your LTP parameter values to ensure they will provide optimal
performance. LTP can still work with bad inputs for these parameters, but you will not
efficiently use the bandwidth.

LTP requires knowledge of the contacts. For actual space operations this is typically
accomplished by ingesting formatted information about satellite and ground contacts into
a program to generate the correct ION formatted files. You can also manually add
contacts on the Duct dialog. The Transmission Rate is used to throttle the LTP data. The
Range defines how long it takes for data to travel between the two nodes.

Contacts are only valid when using LTP.

6.3 Application Messages

Various types of application messages are generated including information, progress,
warning, error, and debug messages. Information, warning, and error messages will be

22
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displayed in the main window message area. All application messages are sent to the
Messages dialog shown in Figure 21. The Messages dialog can be configured to display
specific types of messages. By default, the Messages dialog will display information,
progress, warning, and error messages. Columns in the Messages dialog can be sorted by
clicking on the column header. The Messages dialog is available from the Options menu.

P8 Messages ? x
Time Category Message
(GMT 2017-04-10 20:26:51:559 | Info Configuration C:/Users/mps/ionconfigl has been opened.
Configure... Clear... Expart...

Figure 21 Messages Dialog

Configure

The Configure button provides access to the Configure Messages dialog shown in Figure
22. This dialog provides access to preferences associated with messages. Display
preferences can be set to filter the types of messages (category) displayed in the
Messages dialog. Export Preferences control how the time tag is added to the filename
that is created when messages are exported. See the Export section for details.

P8 Configure Messages ? x

Display Preferences
Info Progress Warning Error [ ] Debug

Export Preferences

[ ] when Exporting Messages Prepend the Timestamp to the Filename

Cancel

Figure 22 Configure Messages Dialog

Clear

The Clear button provides access to the Clear Messages dialog shown in Figure 23. This
dialog provides two ways to clear messages in the Messages dialog. You can clear all the

23
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messages or clear selected messages. Once you clear messages, the messages are
permanently deleted.

P8 Clear Messages ? >

(®) Clear All Messages

(") Clear Selected Messages

Cancel

Figure 23 Clear Messages Dialog

Export
The Export button provides the capability to save all the application messages to a file.

When you push the Export button you will be prompted for a directory and filename.
Export will save all messages, not just the messages currently displayed in the Messages
dialog (i.e. the Display Preferences are not applied). The name you provide for the file
will be modified with a time tag that is added to the filename. The time tag indicates the
time the file was closed. The default is to append the time tag to the filename. For
example:

Filename Input: messages.txt
Filename Output: messages_2017-05-07_13~03~28.txt

If you would like to prepend the time tag to the filename you can set this preference in
the Configure Messages dialog. This would result in the following:

Filename Input: messages.txt
Filename Output: 2017-05-07_13~03~28_messages.txt

6.4 Application Configuration File

The DTN diagram and application preferences are saved in the application configuration
file. The configuration cannot be saved if the DTN diagram is not valid.

6.5 Application Settings

The IONconfig application saves some settings as application settings each time you exit
the application. The next time you run the application, the application will initialize with
the previous application settings. The following application settings are saved:

» Application Window Size

» ION Configuration Files Base Directory
» Configure Messages Selections
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7 FAQ and Troubleshooting

This section addresses Frequently Asked Questions and provides tips for troubleshooting
common gotchas.

7.1 Whatis ION?

The following text is from the Interplanetary Overlay Network (ION) documentation:

“The Interplanetary Overlay Network (ION) software distribution is an implementation of
Delay-Tolerant Networking (DTN) architecture as described in Internet RFC 4838. It is
designed to enable inexpensive insertion of DTN functionality into embedded systems such
as robotic spacecraft. The intent of ION deployment in space flight mission systems is to
reduce cost and risk in mission communications by simplifying the construction and
operation of automated digital data communication networks spanning space links, planetary
surface links, and terrestrial links.

A comprehensive overview of DTN is beyond the scope of this document. Very briefly,
though, DTN is a digital communication networking technology that enables data to be
conveyed between two communicating entities automatically and reliably even if one or more
of the network links in the end-to-end path between those entities is subject to very long
signal propagation latency and/or prolonged intervals of unavailability.”
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